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LANDWISE 

Laboratory Soil Analysis Protocol 

 

Equipment required 

45 × Foil sample trays (size ~ 14 × 12 × 5 cm) 
(tray weight loss negligible at 105°C for 48 hr (~0.4% in trial) therefore no need to pre-heat) 

Desiccators (glass) with active desiccant (‘silica gel rubin’ - red/pink crystals) 

Balance (0.1 g or better precision, e.g. inner room Precisa 2200C; for volumetric soil moisture 
determination) 

Balance (0.001 g or better precision, e.g. outer room Sartorius; for soil organic matter 
determination) 

Balance test weights 

Muffle furnace (with ± 5 °C temperature control) 

Drying ovens (with ± 5 °C temperature control), around 20 sample trays per shelf possible 

15 × Porcelain furnace crucibles (SLS CRU2004) – already labelled with glaze pen (1-15 or 
16-30) 

Furnace heat mats / porcelain tiles, trays & handle, long-handle tongs and gauntlets 

Pestle + mortar 

Ovens room trolley 

‘Landwise Broad-scale Survey Lab Soil Analysis TEMPLATE’ spreadsheet printout for 
recording results (see ..\NEC06345_LANDWISE\Labwork for latest version 

Permanent marker pen 

Blue nitrile gloves, lab coat 

 

Laboratories required 

Ovens Balance Room: volumetric soil moisture, bulk density and soil organic matter. 

Soil Hydrology Lab: slaking and dispersion, hand texturing and temporary sample storage 

Chemistry Lab Acid Fume Cupboard: HCl test for calcareous soil 

  

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork
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Soil sampling and lab analysis schematic (green = field, blue = lab) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Air dry ~60 g sub-sample 
(30°C for ~1-3 d) 

Fixed Volume 
Soil Sample 

Additional 
Soil Sample 

VESS 
assessment 

Oven Drying 
(105°C for 36 h) 

VWC 

BD 

Texture (Hand) 
- Partners 

Vegetation type, 
height and cover 

 

Extra Soil 
Sample 

Texture 
(Hand) - CEH 

Take 0.5-1 g sub-sample 

Split aggregates 

Wet sieve (< 2 mm) 

Sodium HMP and 
Ultrasonic dispersal 

Laser particle sizer 

Take ~20 g 
sub-sample 

Crush and 
sieve 

Slaking & 
Dispersion 

Test 

SOM 

Texture 

2-50-(60/63)-200-600-2000 microns 

< 2 microns – clay 

2 to 50 or 60/63 – silt (USDA or SSEW) 

50 or 60/63 to 2000 – sand (USDA or SSEW) 

 

60/63 to 200 – fine sand (SSEW) 

200 to 600 – medium sand (SSEW) 

600 to 2000 – coarse sand (SSEW) 

HCl test for 
Calcareous 

Soil 

Dry (105°C for 36 h) 

Take ~4 g sub-sample 

LOI (400°C for 16 h) 

Use sub-sample at 
field moisture content 

Retain remainder of air dried sub-sample 

Use if any analysis needs to be repeated 

Re-bag for colour analysis (send to UoR) 
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Sample labelling: Volumetric soil moisture and soil bulk density 

‘V’olumetric samples 

Lab tray label: arbitrary 3 letter site code, field no. and ‘V’ sample no., e.g. ‘SON F1 V1’ 

It is essential that correspondence between the lab tray label and the relevant field sample 
bag label (site code, field code, sample location code, ‘V’, date and time) is accurately 
recorded on the ‘Landwise Broad-scale Survey Lab Soil Analysis’ spreadsheet printout. 

 

Sample labelling: Soil organic matter 

‘A’dditional samples 

Lab tray label: arbitrary 3 letter site code, field no. and ‘A’ sample no., e.g. ‘SON F1 A1’ 

It is essential that correspondence between the lab tray label and the relevant field sample 
bag label (site code, field code, sample location code, ‘A’, date and time) is accurately 
recorded on the ‘Landwise Broad-scale Survey Lab Soil Analysis’ spreadsheet printout. 

Correspondence between crucible number and lab tray label should also be noted on 
spreadsheet printout. 
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Procedure: Volumetric soil moisture and soil bulk density by oven drying (‘V’ 
samples) 

1. Use 100 and 200 g test weights to check 0.1 g precision balance before use (once 
per session), noting on spreadsheet printout. Check balance is level. 

2. Weigh ‘V’ sample in sealed bag (SOILMOIST + BAG) to 0.1 g 

3. Label foil tray (using permanent marker on side). Note correspondence with field 
sample bag label on spreadsheet printout. 

4. Weigh empty tray (TRAY) to 0.1 g. If trays are identical and clean, an average mass 
may be used. 

5. Whilst soil sample is still in bag, carefully split apart any large lumps to aid drying. 
Empty sample into tray, ensuring all material is transferred (lightly brush any 
condensation water droplets onto soil sample before transferring) 

6. Weigh combined sample and tray (SOILMOIST + TRAY) to 0.1 g.  

7. Weigh emptied bag (BAG) to 0.1 g (for comparison with reference bag mass). Retain 
empty bags in order until analysis complete, then dispose of ‘V’ sample bag. 

8. Place samples in oven and dry at 105 °C for ~ 36 hours (up to 60 hours ok). Note 
oven used and start/end times on spreadsheet printout. The trays should be loaded 
from the top shelf downwards and unloaded from the bottom upwards. Note oven 
usage details in log book. 

9. Upon completion of drying, immediately weigh combined dry sample and tray 
(SOIL105 + TRAY) to 0.1 g (ok to handle samples directly from 105 °C oven). It is 
important to weigh the samples as soon as they are removed from the oven as they 
will gain mass (moisture from the atmosphere) if left out before weighing (this is more 
significant than an exact drying time). Can remove in batches of say 5 trays. 

10. Dispose of soil sample in steel soil bin 

11. Transfer values from the ‘Landwise Broad-scale Survey Lab Soil Analysis’ 
spreadsheet printout to the spreadsheet itself. The spreadsheet name should be 
prefixed with the site name and field no. (e.g. UoR Sonning Field 1… .xlsx) and 
saved to the appropriate site sub-folder in ..\\NEC06345_LANDWISE\Broad-scale 
Survey Site Data. The completed spreadsheet printout should be scanned, named 
similarly and saved to the same sub-folder. 

12. Foil trays may be reused for subsequent analyses so long as mass equals 3.8 g 
± 0.1 g as potential mass error and cross contamination negligible (remember to re-
label trays correctly on next use) 

 

Calculations: Volumetric soil moisture and soil bulk density by oven drying 

Volumetric soil moisture content (cm3/cm3) = Volume water (cm3) / Sample volume (cm3) 

Volume water (cm3) = (Mass wet soil (g) – Mass dry soil (g)) / Density water (g/cm3) 

Density water = 1 g/cm3 

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Broad-scale%20Survey%20Site%20Data
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Broad-scale%20Survey%20Site%20Data
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Volumetric soil moisture content = VOLWATER / VOLRING 

VOLWATER = (SOILMOIST - SOIL105) / 1.0 

SOILMOIST = (SOILMOIST + TRAY) - TRAY 

SOIL105 = (SOIL105 + TRAY) - TRAY 

VOLRING = 100.1 cm3
 (50 mm inside diameter and 51 mm length ring sample) 

 

Bulk density (dry; g/cm3) = Mass dry soil (g) / Sample volume (cm3) 

Bulk density (dry) = SOIL105 / (VOLRING) 

 

Also... 

Gravimetric soil moisture content (g/g) = Mass water (g) / Mass dry soil (g) 

Gravimetric soil moisture content = (SOILMOIST - SOIL105) / SOIL105 

 

Volumetric soil moisture = Gravimetric soil moisture * (Bulk Density / Density Water) 

Volumetric soil moisture = ((SOILMOIST - SOIL105) / SOIL105) * (SOIL105 / VOLSAMPLE) 

Volumetric soil moisture = (SOILMOIST - SOIL105) / VOLSAMPLE 
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Procedure: Soil organic matter by loss on ignition (‘A’ samples) 

1. Label foil tray (using permanent marker on side). Note correspondence with field 
sample bag label on spreadsheet printout. 

2. Air dry ~ 60 g representative sub-sample (carefully split apart any large lumps whilst 
still in bag, transfer soil to tray, dry at 30 °C in oven or on the lab bench). Drying may 
take around three days, depending on initial moisture content and soil type. 

3. Take ~ 20 g sub-sample from each tray (made up of representative particles) 

4. Crush sub-sample using clean pestle and mortar (do not use a coffee grinder or food 
mill as roots will be accidentally incorporated), removing obvious stones and roots, 
and sieve to approximately < 0.4 mm. 

5. Label another set of foil trays, as ‘1.’ 

6. Add crushed soil to ‘SOM’ tray 

7. Dry crushed samples in oven at 105 °C for ~ 36 hours (up to 60 hours ok) 

8. Meanwhile, heat the empty crucibles at 400 °C for 2 hours in furnace, then cool to 
room temperature in a desiccator (~ 30 min). NB This stage will not be needed if the 
crucibles have been up to 400 °C recently and have been stored in desiccators. 

9. Transfer desiccator containing crucibles to balance room. 

10. Use 10 and 20 g test weights to check 0.001 g precision balance before use (once 
per session), noting on spreadsheet printout. Check balance is level. 

11. Remove crushed sample trays from hot oven (in batches of three), place on tray and 
transfer to balance room 

12. Note crucible number and weigh (CRUCIBLE Pre-analysis) to 0.001 g. Tare balance 
and add approximately 4 g of crushed dried soil (SOIL105) using spatula, noting to 
0.001 g. Retain remainder of crushed dried soil for HCl Test for calcareous soil 

13. Repeat ‘11’ and ‘12’ for other crushed soil batches. Return crushed soil to oven 
(105 °C) if available, in case of reanalysis. 

14. Heat soil in crucibles to 400 °C (Nelson & Sommers, 1996) for 16 hours overnight in 
furnace (960 min), so that the timing finishes when you are available. Note on 
spreadsheet printout. Cool crucibles to room temperature in desiccators (~ 30 min). 
Do not overload desiccators – crucibles should not touch; leave the desiccator lid 
open a fraction initially to avoid vacuum formation on cooling. 

15. Weigh soil in crucible (SOIL400 + CRUCIBLE) 

16. Dispose of analysed soil sample in steel soil bin and clean out crucible using brush 
and dry paper towel. Weigh each empty crucible (CRUCIBLE Post-analysis) to 
0.001 g. 

17. Once the SOM and HCl Test for calcareous soil is complete, discard the sieved dried 
soil samples 



 Landwise_Laboratory_Soil_Analysis_Protocol_EIDC.docx 7 

18. Once the slaking and dispersion test, hand texturing and texture by sieving and laser 
particle sizer are complete, transfer any remaining air dried soil from trays to original 
‘A’ sample collection bags, seal and retain (send to UoR for colour analysis) 

19. Transfer values from the ‘Landwise Broad-scale Survey Lab Soil Analysis’ 
spreadsheet printout to the spreadsheet itself. The spreadsheet name should be 
prefixed with the site name and field no. (e.g. UoR Sonning Field 1… .xlsx) and 
saved to the appropriate site sub-folder in ..\\NEC06345_LANDWISE\Broad-scale 
Survey Site Data. The completed spreadsheet printout should be scanned, named 
similarly and saved to the same sub-folder. 

20. Foil trays must not be reused if too dusty! 

 

Calculations: Soil organic matter by loss on ignition 

Organic matter (%) = ((SOIL105 – SOIL400) / SOIL105) * 100 

SOIL400 = (SOIL400 + CRUCIBLE) – CRUCIBLE 

 

  

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Broad-scale%20Survey%20Site%20Data
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Broad-scale%20Survey%20Site%20Data
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HCl Test for calcareous soil 

Use crushed sieved soil (spatula scoop) 

Follow Natural England (2008) method: NE Soil texture (TIN037 edition 1) - incl. HCl test.pdf  

1. Use clean beakers labelled 1-31 

2. Add spatula scoop of crushed, air dried soil from corresponding sample number to 
labelled beaker 

3. Transfer to fume cupboard (with screen down, extractor and light turned on) 

4. Add a few drops of 20% hydrochloric acid to beaker, enough to cover sample 

5. Record calcareous content according to below classes 

6. Dispose of sample in fume cupboard sink with a lot of running water to dilute 

CaCO3 Class Visible Effects of HCl Addition 

None None 

Slight Slight effervescence confined to individual grains, just visible. 
Slightly more general effervescence visible on closer inspection. 

Moderate Moderate effervescence; obvious bubbles up to 3 mm diameter. 

Strong General strong effervescence; ubiquitous bubbles up to 7 mm 
diameter; easily seen. 

 

Creating HCl 20% solution from HCl 32% concentrated stock 

Requires: 

1000 ml measuring cylinder 

200 ml beaker 

1000 ml plastic storage container 

1. Rinse out all apparatus using ultra pure de-ionised water. 

2. Carefully add 600 ml of ultra pure de-ionised water to the 1000 ml measuring cylinder, 

then transfer cylinder to the acid fume cupboard. 

3. In the fume cupboard transfer 200 ml of concentrated HCl into the 200 ml beaker, then 

carefully add the HCl to the measuring cylinder 

4. Top up with a further 200 ml of ultra pure de-ionised water and mix again. 

5. Carefully decant the solution into the plastic container and seal the container. Wipe down 

any spillage with paper towels and de-ionised water and clean the apparatus used making 

sure not to inhale any fumes produced. 

6. Label the container (‘HCl 20%’ and name) and return it to the acid fume cupboard. 

 

  

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/NE%20Soil%20texture%20(TIN037%20edition%201)%20-%20incl.%20HCl%20test.pdf
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Slaking and dispersion test 

Use air dried soil (aggregate particle) 

Follow method: McGarry Visual Soil Test - see pp. 25-26 for Slaking and Dispersion Test.pdf  

1. Use clear and clean beakers, labelled 1-15, on lab bench 

2. Add DI water; enough to cover sample and around same head of water above 
sample in each beaker 

3. Drop similar sized air-dried aggregate from corresponding sample number to labelled 
beaker 

4. Note start time 

5. After 10 minutes and 2 hours of immersion record visual judgement of degree of 
dispersion on scale of 0-4 as detailed below 

6. Dispose of sample down sink with plenty of water 

Dispersion 
Scale 

Visible Effects of Dispersion 

0 No dispersion, though aggregate may slake. Note if slaking does 
occur (Y/N) 

1 Slight dispersion; recognised by slight milkiness in the water 
adjacent to the aggregate 

2 Moderate dispersion with obvious milkiness 

3 Strong dispersion with considerable milkiness and about 0.5 the 
original volume dispersed outwards 

4 Complete dispersion; the original aggregate is completely dispersed 
into clay, silt and sand particles 

Slaking describes the breakdown of aggregates into microaggregates. The products of 
slaking can reform to produce larger aggregates.  

Dispersion describes the breakdown of aggregates into primary soil particles of sand, 
silt and clay. Dispersion into primary particles is irreversible and results in undesirable, 
massive structure. 

  

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/McGarry%20Visual%20Soil%20Test%20-%20see%20pp.%2025-26%20for%20Slaking%20and%20Dispersion%20Test.pdf
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Example photos and scores (modified from .pdf above): 
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Hand texturing 

Use additional soil sample at field moisture (desert spoonful) 

Follow method: NE Soil texture (TIN037 edition 1) – incl. HCl test.pdf and EA Think Soils 
quickguide – Hand Texture.pdf  

1. Take dessert spoonful of soil 

2. If dry, wet up gradually, kneading thoroughly between finger and thumb until crumbs 
are broken down. Enough moisture is needed to hold the soil together and for the soil 
to exhibit its maximum stickiness 

3. Work soil between fingers to get a feel for particle components (do not wear gloves – 
follow risk assessment) 

4. Follow the paths in the below figure and record texture class abbreviation in square 
brackets 

5. Dispose of samples in soil bin 
 

Adapted from Environment Agency (2007) Think Soils EA Think Soils quickguide – Hand 
Texture.pdf  
 

[Sa] 

[LoSa] 

[SaLo] 

[SaSiLo] 

[SiLo] 

[ClLo] 

[SaClLo

] 

[SiClLo] 

[Cl] 

[SaCl] 

[SiCl] 

file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/NE%20Soil%20texture%20(TIN037%20edition%201)%20-%20incl.%20HCl%20test.pdf
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/EA%20Think%20Soils%20quickguide%20-%20Hand%20Texture.pdf
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/EA%20Think%20Soils%20quickguide%20-%20Hand%20Texture.pdf
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/EA%20Think%20Soils%20quickguide%20-%20Hand%20Texture.pdf
file://///nercwlctdb/projects/projects1/NEC06345_LANDWISE/Labwork/EA%20Think%20Soils%20quickguide%20-%20Hand%20Texture.pdf
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Texture by sieving and laser particle sizer 

 Use sub-sample of additional sample at field moisture. 

 Use falcon tubes labelled 1-31. 

 Run standard at the start of the next batch after 100 samples. See QAS procedure 
on P5 in blue folder. 

 At the start of each large batch run Soil3 SOP – check 3 replicates are in agreement. 

 Run below steps for 1 sample of each soil type in batch before preparing all samples, 
to test protocol and amount of sample required for correct obscuration levels first. 

 If need to make up more sodium hexametaphosphate see method on P7 of blue 
folder. 

Sample Preparation 

1. Preapare 1 sample for each soil type before rest of batch, to test sample weight 
required for correct obscuration levels as well as SOP settings. 

2. Weigh out 0.5 - 1.0 g of representative Additional sample into falcon tube, breaking 
up any agglomerates (0.5g for fine, increasing with coarseness). 

3. Note sample ID, tube number and weight in MS2000 logbook. 
4. Add 5ml of 5% sodium hexametaphosphate using a syringe. 

If more sodium hexametaphosphate is needed see method on P7 of blue folder. 
5. Make sample up to 50ml with DI water. 
6. Overturn/shake and mix thoroughly using vortex.  
7. Leave for at least one hour before analysis. 
8. Place half of batch falcon tubes in ultrasonic bath and set to run for 5 minutes, to 

reduce MS2000 run time and break up aggregates before sieving. 

MS2000 - start up 

1. Turn on MS2000 optical bench, HydroG unit and computer – 5 sockets. 
2. Turn on laser (button on rear of optiocal bench, blue light will come on).  
3. Leave laser to warm up for at least 30 minutes (can prepare samples during wait). 
4. Check HydroG windows are clean and ensure flow cell is in place in optical bench. 
5. Log on to computer (pw: Malvern) and open MS2000 software, enter operator initials. 
6. Open new file; File > New > enter file name “yyyy_mm_dd_description” > Save 

Will create new name.mea file into which all measurement details and data will be 
stored. 

MS2000 - cleaning and background checking (at start of batch) 

7. Go to Measure in menu bar and select ‘Manual’ to open measurement display. 
8. Click on ‘Accessories’ icon to open HydroG manual control box. 
9. Enter 3 into number of clean cycles and tick the degas option – click clean. 
10. When green light by the clean button has gone out (~3min), set stirrer to 700rpm and 

pump to 1600 rpm using sliders. 
11. Wait for 30 seconds to equilibrate. 
12. In measurement display click ‘Start’ to perform background measurement (laser 

should auto-align. Can realign if needed by clicking ‘align’ in measurement display). 
13. The background is acceptable if the signal declines rapidly from the low number of 

detectors (~100-300) to below 20 at detector 20 and continues to decline at higher 
detector numbers. 

14. If background is not acceptable, see Mastersizer 2000 Essentials P4-6 for reasons. 
Turn off stirrer and pump and check flow cell for bubbles or dirt.  
If dirt is visible repeat 3 clean cycles.  
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If bubbles are visible set stirrer and pump to max for 5s, turn off and degas. Or turn 
stirrer and pump to zero and ultrasonics onto max for 30s, turn off and turn stirrer and 
pump to max for 10s to allow air to dissipate. 
Return to original settings and recheck background, if still unacceptable it may be 
necessary to remove windows and thoroughly wash/clean with lint-free wipes on lens 
tissue. TAKE CARE NOT TO SCRATCH CELL WINDOWS OR REMOVE COATING. 

15. When background is acceptable turn stirrer and pump to zero and close accessory 
and measurement windows. 

16. Check whether QAS run is required; every 100 sample runs. If so see QAS 
procedure on P5 of blue folder. If not continue to measurement steps below. 

MS2000 – measurements 

17. For first measurement in batch go to ‘Measure’ and select ‘Start SOP’, select 
Soil3_HydroG  

18. Follow the on-screen instructions, entering sample ID as the sample name  
(eg. SON_F1_1) and click OK. 

19. Only proceed to measurement if happy with background. Re-align laser if necessary. 
20. Position retort stand with clamps beside HydroG dispersion unit and place funnel with 

2mm sieve over unit. 
21. Overturn and mix sample and pour contents through sieve directly into HydroG, 

taking care not to spill any and keeping in centre of sieve. 
22. Ensure all sample is removed by rinsing tube and lid with DI water into sieve/funnel. 
23. Wash through any material on sieve and funnel with DI water. 
24. Click ‘Start’ to begin measurement sequence (Ultrasonic 60s, Delay 30s, 3 

measurements). Yellow highlighted box will show stage of process. 
25. Move sieve, funnel, tube and lid to sink and wash with DI before next sample. 
26. The ‘Soil3_HydroG’ SOP will run 3 replicate measurements, ensure these are 

consistent. Highlight records in ‘Records’ tab and click on ‘Result Analysis’ tab. The 
repeats should lie on top of each other on the curves. 

27. If unhappy with the data, measure again by pressing the ‘Measure Sample’ tab in the 
measurement display window. 

28. If there is large variation, the unit may not be working effectively or the SOP may 
need adjustment. Adjustment may involve increasing averaging times (coarse) or 
different stirrer/pump speeds and ultrasonic time (coarse, bubbles or agglomeration).  

29. If unhappy with the data click ‘No’ to ‘Do you want to run SOP again?’ This will leave 
the sample in the HydroG for manual measurements (See P10 of blue folder). 

30. Check the obscuration level, it should be 10-40%  
(optimal: coarse = 35%, if D50 ≥ 50um = 25%, D50 ≤ 5um = 15%). 
Record obscuration level in MS2000 logbook. 
 

31. If happy with measurement close windows before continuing measurements with 
‘Soil1_HydroG’ measurements without replicates (Ultrasonic 60s, Delay 30s, 1 
measurement) Measure > Start SOP > Soil1_HydroG  

32. Follow the on-screen instructions and same steps above, except for the replicate 
checking (steps 26-28). 

33. At start of batch run 1 sample for each soil type first, to test SOP settings and 
whether correct amount of sample required for correct obscuration levels. If 
obscuration is too high reduce sub-sample weight, if too low increase weight. 

34. Prepare rest of batch samples according to trial obscuration levels and run using 
Soil1_HydroG SOP.  
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MS2000 - end of batch 

35. When the batch of samples is finished, go to ‘Measure’ > ‘Manual’ > ‘Accessories’ 
icon. 

36. Perform 3 clean cycles with degas option checked. When finished click ‘Measure 
Background’ and ‘Start’ in measurement display.  

37. Check background is acceptable – otherwise perform more clean cycles. ALWAYS 
LEAVE CLEAN WATER IN FLOW CELL; NEVER LEAVE DRY OR FULL OF 
SAMPLE. 

38. Ensure stirrer and pump are off and close windows. 
39. Ensure file saved; File > Save as 
40. Export data; Highlight records to export, File > Export Data > Select ‘Results 

Analysis’, tab delimiters, check header row and export to clipboard. Paste data into 
excel workbook and save onto memory stick and then into project folder. 

41. Copy measurement file from directory onto memory stick and then into project folder. 
42. Switch off laser beam at back of optical bench, close down computer, turn off all 

sockets and leave bench clean and tidy. 
43. Discard Additional samples when happy with results. 

 

Soil colour 

Use air dried soil – retain a small bagged sample for later analysis by UoR. 

Return air-dried additional sample to sample bag and deliver to UoR. 

 

Notes 

Soil samples for analysis should be collected from the walk-in fridge room in the Chiltern 
Wing. They should be in a labelled box. Samples should be analysed as soon as possible 
after collection, ideally within one month. 

See ‘Basic Furnace Operation Protocol’ and ‘Oven Operation’ for specific usage instructions. 
In addition, oven/furnace use should be recorded in the appropriate log book and the air 
extraction system and furnace extract should be operational. Furnace usage may need to be 
booked in advance. Take great care when using furnace. After use, turn off furnace at both 
switches. Leave cooling furnace trays in an empty oven (not on the side). Handle hot 
crucibles with tongs. Handle cold crucibles using gloves to avoid contamination from any oil 
etc. on fingertips. Trays should be loaded from the top shelf downwards and unloaded from 
the bottom upwards. 

Indicating silica gel ‘rubin’ desiccant which has expired (turned yellow/orange) can be re-
activated by heating in trays in the oven at 80 °C until the colour changes back to red/pink. 
Use gloves when handling silica gel. Inhaling silica gel dust should be avoided – use a face 
mask if necessary. Blue indicating silica gel should no longer be used as the dust has been 
identified as carcinogenic. 

Pansu and Gautheyrou (2006) note that loss on ignition removes organic matter at 300-
500 °C and lattice and bound water at 350 – 1000 °C. The procedure outlined above follows 
the 400 °C temperature recommendation by Nelson & Sommers (1996), which removes 
organic matter, but causes minimal dehydroxylation of clay minerals. 

file://///nercwlctdb/projects/projects1/NEC04961_COSMOSUK/Calibration/Lab%20Analysis/SOP_Carbolite_Furnace_OperationJan2010.doc
file://///nercwlctdb/projects/projects1/NEC04961_COSMOSUK/Calibration/Lab%20Analysis/SOP_Oven%20OperationJan2010.doc
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The oven dried soil samples for soil organic matter determination should be weighed hot 
directly from the oven in small batches of 3 trays to avoid any potential increase in moisture 
content from atmospheric water vapour (due to the number of trays it is not practical to cool 
in desiccators). Use of desiccators is not required for the oven dried soil samples for 
volumetric soil moisture analysis as the sample mass is much larger so any effect will be 
negligible if the soil sample is weighed as soon as it is cool. 
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